
Trimble Unity Construct - Bidding 
Guide

September 2024



Trimble Unity Construct

Page i

Table of Contents

Bidding 2

Bid Packages 5

Bidding Details 7

Bid Scope 13

Potential Bidders 22

Invited Bidders 27

Bid Documents 33

Questions/Responses 34

Bid Tabulation 36

Permissions 38

Bid History 39

Additional Actions 40

Assistance for Invited Bidders 44

Support Information 45

Register with e-Builder 45

Access the Bid Package 46

Enter the Invitation Key 47

Review Package Invitation 48

Ask Questions / View Responses 49

Submit Your Bid Response 49

Recall your Bid Response 50

Submit a Quote 51



Trimble Unity Construct

Page 2

Bidding
Owners, general contractors and other industry participants go through a bidding process to purchase goods 
and services associated with the development and construction of capital projects. Trimble Unity Construct's 
Bidding module helps manage this bidding process and streamlines the exchange of documents, drawings 
and communications that surround it.

Without an online system, the typical bid process involves the distribution of plans and specifications to mul-
tiple bidders by hand delivery or express mail, which is expensive and very difficult to coordinate and manage. 
Though the bidding process itself is fast paced, it involves multiple back and forth exchanges, and requires 
that each step in the process be documented to minimize liability or misunderstandings later on. The com-
munication process is difficult to manage, prone to errors, and labor intensive. To save time and money, bid 
managers often invite a smaller number of bidders or send partial information to bidders. At best, this results in 
less competitive bid results. At worst, this results in lost work, lawsuits, or projects that are not profitable 
because incorrect vendors were selected.

Benefits of using the Bidding Module in Trimble Unity Construct

The Trimble Unity Construct Bidding module is ideal for owners and general contractors or companies that 
operate in that capacity (e.g., third party program management companies). 

This module provides the following benefits:
 l Improved bid coverage which leads to more competitive pricing
 l Streamlined exchanges of information such as plans and specifications between the bid manager 

and invited bidders. The bidders can access the Bidder's Portal and communicate directly with the 
bid manager.

 l More efficient communications with automatic message and status tracking
 l Cost reduction (i.e., shipping, printing, resources)
 l Reduction in the time and effort associated with tracking and managing the entire bidding process
 l Process standardization which increases efficiency and eliminates errors
 l Easier access to historical data to improve future projects
 l Increased competitive advantage with a more streamlined process

Key Concepts of Bidding

The following concepts are used within Trimble Unity Construct:
 l Project: To begin the bid process you must first create a project. Each real world project that your 

organization is  participating in must be associated with a project in Trimble Unity Construct.  Your 
Project Administrator or Manager will be able to add you as a member of a project in Trimble Unity 
Construct if you are working on it.

 l Contact: To invite a bidder to one or more of your projects, you must have the bidder created as a 
contact first. Each contact invited must have a fax and/or email address. 



Trimble Unity Construct

Page 3

Note: A contact is different from a standard Trimble Unity Construct user. A Trimble Unity Con-
struct user is someone that has been added to the Trimble Unity Construct account as a par-
ticipant to a set of your projects. A Trimble Unity Construct contact has a record of contact 
information (e.g. phone number, fax, email address, street address, etc.) associated with a 
Trimble Unity Construct company. These contacts do not have access to all of your Trimble Unity 
Construct project information; but can access only the project bid information that the contact is 
invited to. For every contact that is invited to bid, there will be a historical record of their par-
ticipation in the contact details. 

 l Company: Each Trimble Unity Construct contact is associated with a Trimble Unity Construct com-
pany. There can be more than one contact associated with a company but only one company can be 
associated with a contact. Each contact can be an Invited Bidder and there can be more than one 
contact associated with a company that has been invited to bid. For every contact associated with a 
company that is invited to bid on a project there will be a historical record of their participation in the 
company details.

The Bidding Process Using Trimble Unity Construct

Typically, there are three steps in the bidding process:

 1. Analyze the Bids: Once the responses are submitted, the bid contact is notified. The bid contact 
can then review each submitted response and determine the best qualified bidder for the job. The 
Trimble Unity Construct Bidding module updates the details of each invited bidder real-time when 
their status and/or responses are updated or submitted.

 2. Award the Project to the Winning Bidders: Once the winning bidder has been determined, the 
bidding manager has the option to send a notification to the winner and/or losing bidders. For each 
contact invited to bid, Trimble Unity Construct will keep track of their bidding history, such as the 
communications exchanged, whether they were awarded on their jobs, their statuses, etc.

 3. Close the Project: After awarding the bidders you can close the project and begin executing the 
work.

The Bidding Process Using Trimble Unity Construct
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Access the Bidding Module 

You can access the Bidding module of Trimble Unity Construct using either of the following methods.

To access the Bidding page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

To access the Bidding page from within a project 
 l Click the Project Bidding link.

The Bid Packages page with a list of bid packages for the current project is displayed. 
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Bid Packages
The Bid Packages page provides detailed information about the bid package and project. On this page, inform-
ation about the pre-bid meeting, bid contacts, tentative project start and end dates can also be viewed. Con-
sultants, managers, auditors and other project bid participants might access this page for more granular 
information such as whether or not attendance to the pre-bid meeting is required, whether bids will be accep-
ted after the bid due date, if adjustments are allowed on the bid tabulation, and if available, access to the public 
bids URL. 

You can access the Bid Packages page from the top navigation menu or from within a project. 

Tip: If you are already working on another module within the same project, you can access the Bidding mod-
ule from the Project Menu located on the left side of the page. This will help you avoid having to reselect your 
project.

To access the Bid Packages page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

To access the Bid Packages page from within a project 
 l Click the Project Bidding link.

The Bid Packages page with a list of bid packages for the current project is displayed. 
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Bid Package Details

Add or Edit Bid Packages

The Add/Edit Bid Package Details page allows administrators and bid managers to complete or edit the 
details of a bid package. From this page, the package and all related details can be defined such as the tent-
ative project start and end dates, whether this is a private or public bid, if a pre-bid meeting is required and if 
bid submissions will be accepted after the bid due date. This information will be available for internal parties 
to access, such as account administrators, managers and auditors. 

To add bid packages to the project
 1. Go to the Bid Packages page.
 2. Click Add Bid Package.
 3. On the Add Bid Package Details page, complete all necessary fields. 
 4. Click Save.

To edit a bid package
 1. Go to the Bid Packages page.
 2. Click Edit beside the bid package.

The Edit Bid Package Details page is displayed.
 3. Make all necessary changes.
 4. Click Save.

Close Bid Packages
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After the bidding process is completed and the bid has been awarded, the bid package can be closed. 
Once the project bid is closed, the status in the bid package details will change to closed. 

Closing the bid package revokes access to the bid package for all invited bidders except for the awarded 
bidder. When the bid package is closed, bidders who have not been awarded will no longer see the bid 
package listed when they log into the Bidder Portal. Once the award has been granted, the awarded bidder 
can potentially be added as a licensed e-Builder user.

Once closed, the bid package can be reopened at a later date if necessary.

This task can be completed by:
 l Pre-construction Managers
 l Estimating Coordinators

Note: The Close button is available on every tab of the Bid Package Details page. 

To close a bid package
 1. Go to the Bid Packages page.
 2. Click Edit beside the bid package.

The Edit Bid Package Details page is displayed.

 3. Click Close.
 4. Click Yes, Close the Bidding to confirm the action.

Related Topics:
 l Additional Actions in the Bidding Module

Bidding Details
The Bidding Details tab displays all of the project's bid information. Depending on your role in the project, you 
can view and edit all the details of the bid package from this page. 

To access the Bid Packages page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

Add Data to Custom Fields
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Custom fields are designed to help further filter or refine your project bids by allowing you to track additional 
information. For example, custom fields can be used to store information such as the owner company and 
lead architect company related to this project or the square footage. 

Custom fields are defined by the e-Builder Administrator in the Setup area. Your particular project may or 
may not have custom fields defined. 

Note: The values of these fields are populated by the roles or users that have the Modify Bid permission, 
such as a Pre-construction Manager or Estimating Coordinator. 

To add data to custom fields
 1. Go to the Bid Package Details page.
 2. On the Bidding Details tab, click Edit.
 3. Click the Custom Fields tab at the bottom of the page.
 4. Complete the custom fields as needed.
 5. Click Save.

Add Notes

The Notes tab can be used to quickly add notes of importance relating to the project bid. 

For example, the Estimating Coordinator can add a note to let internal team members know that there is cur-
rently an addendum that will be added to the bid contract and that is currently being approved by the board. 

For each note entered, the name and company name of the user adding the note will be displayed along 
with the date when it was added. In e-Builder, the total number of notes created for the bid package will be 
displayed in parenthesis on the Notes tab header.

Note: Only internal e-Builder users will be able to see these notes. No invited bidder will be able to 
access this information. The invited bidder will only see the bid document folders contained within the Bid 
Documents Folder.

To add a note
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Notes tab.
 4. Click Add Note.
 5. Enter your note in the Note field.
 6. Click Save.

Attach or Remove Documents

On the Documents tab, you can view attached documents, attach documents or remove attached doc-
uments.

Tip
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In IE 10, Firefox, Chrome, and Safari browsers, you can simply drag and drop documents from your 
local directory onto the Attached Documents tab. This can be done to attach documents throughout e-
Builder Enterprise.

To attach a document
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Documents tab.
 4. Click Attach Documents.
 5. In the Select Attachment Method section, select your method of attachment.
 6. Click Browse For Files...
 7. Search for and select the file you want to attach.

You are returned to the Attach Documents dialog box.

 8. If you are attaching files from e-Builder, go to step 9.
—Or—
If you are uploading files from your computer, in the Select an e-Builder Destination folder 
field, click Browse.

 9. Search for and select the e-Builder destination folder.
 10. Click Attach Selected.

To remove documents
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Documents tab located toward the bottom of the page. All available documents are lis-

ted.
 4. Select the check box next to the document(s) you want to remove.
 5. Click Remove.

Attach or Remove Forms

On the Forms tab you can attach supporting workflows to the project bid. The forms that can be attached 
are any open/ closed forms that have been created in the project.

To attach forms
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Forms tab located toward the bottom of the page.

All available forms are listed.

 4. Click Attach Forms.
The Fill Out Form on [Project Name] popup window is displayed with all workflow forms in your 
court.
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 5. Select the check box next to the form(s) you want to attach.
 6. Click Attach.

To fill out a form
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Forms tab located toward the bottom of the page.

All available forms are listed.

 4. Click Fill Out Form.
The Fill Out Form on [Project Name] popup window displays with all available forms listed.

 5. Click the title of the form type you want to fill out.
The Fill Out Form window displays.

 6. Enter all required fields.
 7. Click Post Form.

To remove a form
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Forms tab.
 4. Select the check box next to the form you want to remove.
 5. Click Remove.

Attach or Remove Processes

You have the ability to view attached processes, attach processes or remove an attached process.

To attach a process
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Processes tab.
 4. Click Attach Processes.

The Attach Processes from [Project Name] popup window is displayed listing all available pro-
cesses.

 5. Select the check box next to the process you want to attach.
 6. Click Attach.

To remove a process
 1. Go to the Bid Package Details page.
 2. Click the Bidding Details tab.
 3. Click the Processes tab.
 4. Select the check box next to the process you want to remove.
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 5. Click Remove.

Available on the Bid Package Details page

Toolbar Buttons
 l Save: Click to save changes to the bid package details.
 l Cancel: Click to disregard changes.

Bid Package Fields
 l Project: Displays the project name.
 l Project Number: If available, the project number displays in this field. Project numbers allow you to 

have a unique identifier for each of your projects. Account administrators can add project numbers 
by going to Administration Tools > Projects > Project Settings > Choose a custom field option from 
the Project Number Custom Field drop-down menu.

 l Bid Package: Enter the name of the bid package in this field. This field is required.
 l Status: Displays the status of the bid package.
 l Bid Package Description: Enter a description of the bid package in this field.
 l Allow Public Bids?: Select to make this a public bid package. When selected, public bid packages 

cannot be opened before the bid due date. In the view mode, a link to the Bidder Portal will be dis-
played in the Public Bid Link field for all public bid packages. This link is available here for easy dis-
tribution.

 l Allow Adjustments: Indicates whether or not adjustments are allowed to the bid tabulation. When 
public bids are allowed, then this check box is selected by default and can be modified by bid man-
agers while editing bid package details. When public bids are not allowed, this check box is disabled 
by default and cannot be modified. See Bid Tabulation for more information.

Package Invitation Fields
 l Pre-Bid Meeting Date/Time: If applicable, select the date and time of the pre-bid meeting.
 l Pre-Bid Meeting Location: If applicable, enter the location of the pre-bid meeting.
 l Required to Attend Pre-Bid Meeting?: Select this check box if potential bidders are required to 

attend the pre-bid meeting. This field is applicable only if the pre-bid meeting details are provided.
 l Bidding Contact: Select a bidding contact from the drop-down menu. This will be the person that 

potential bidders will contact if they have questions about the project.
 l Bid Start Date/Time: Select the date and time that project bids will begin being accepted. This field 

is required.
 l Bid Due Date/Time: Select the date and time that project bids will be due. This field is required.
 l Bid Time Zone: Select a time zone for the bid package. This field is required.
 l Tentative Award Date: Enter the latest tentative date that a package will be awarded.
 l Tentative Work Start Date: Enter the tentative date that work is schedule to start on the project.
 l Tentative Work Finish Date: Enter the tentative date that work is schedule to end on the project.
 l Allow Bids After Due Date?: Select this check box to allow bidders to submit their bids after the 

due date. Optionally, you can specify a date and time as well.
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 l Bid SqFt.: Enter the square footage of the project. This information might be pertinent for admin-
istrators.

 l Bid Instructions Document: Click the Select file link to attach bid instruction documentation. Only 
the name of this document will be available in read-only mode. Viewers will not be able to access 
this file.

Response Form Fields
 l Allow Electronic Bid Submission: If the Enable Electronic Bid Submission setting is enabled on 

the account (Setup> Administration Tools> Bidding> Options), this check box is selected by default 
when a new bid package is created. However, Bid Managers can disable the ability for bidders to 
submit electronic bids for the specific bid package by clearing this check box. 

Note: If the Enable Electronic Bid Submission setting is enabled and a bidder enters response 
information through the Bidder's Portal and saves it (without necessarily submitting it), the Allow 
Electronic Bid Submission setting on the bid package is disabled and cannot be turned off.

Restricting electronic bid submissions might be necessary for public bid clients who require hard 
copy signatures. Typically, these clients bid on their projects through websites, newspapers, and 
other public means. For more information on this account setting, see Bidding Options.

 l Bid Documents Folder: If the Bid Package is linked to the Plan Room, this field is not displayed. If 
available, select the document folder where bid documents will be stored for internal project par-
ticipants to access.

 l Response Documents: Use this section to specify how bidders can upload the response doc-
uments. These settings also prevent bidders from submitting unrequested files with their bid 
response.

 o Free-form File Upload: Select to allow bidders to optionally upload unspecified documents 
as attachments. When selected, a drag and drop zone will be displayed for bidders on the 
Response Documents tab of the Bidder's Portal.
If this setting is left unchecked, bidders can only upload response documents to the Selected 
Custom File Fields listed under Predefined File Upload. 

 o Predefined File Upload: Use this field to specify Bid Submission Custom fields that can be 
used to request for specific file uploads from the bidders. This field allows bidders to submit a 
predefined document through each defined custom file field. All account level bid submission 
custom fields of the type "File" (setup by the Admin on the Bid Submission Custom Fields 
page) are available for selection from the Custom File Fields list in the Edit mode. 
The bid submission custom fields specified here will be available for bidders on the 
Response Documents tab of the Bidder's Portal.

 o Bid Response Documents Folder: Select the folder path that bid documents will be 
uploaded to as they are received in the Bidder Portal.

 l Additional Info: Use this section to add additional response information using bid submission cus-
tom fields. 

 o Bid Submission Custom Fields: Select the required fields to display to the bidders from the 
non-file type custom fields available. The custom fields specified here will be available for bid-
ders on the Additional Info tab of the Bidder's Portal.

bidding _settings_ options.htm#enableelecbidsub
bidding_custom_fields.htm
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 l Bid Award to Commitment: If this setting is enabled on the account, this field is displayed and 
gives you the opportunity to determine the whether or not a commitment process can be created 
upon awarding a bid. If so, choose the method and/or process to be initiated. Choose from the fol-
lowing options:

 o No Commitment (None) - Select to disallow the initiation of a commitment process upon 
awarding a bid package. Commitment fields will auto-populate with data from the awarded 
bid package.

 o Commitment (Non Process Commitment) - Select to enable the creation of a non-process 
commitment upon awarding a bid package.

 o Process - All commitment process display in this section for you to choose one that may be 
initiated and populated with contract data from an awarded bid package.

Tabs
 l Custom Fields Tab: If available, this tab lists all bid package custom fields. Custom fields are cre-

ated by account administrators and used to capture additional information about bid packages. For 
more information, see Bidding Custom Fields.

 l Notes Tab: Lists all available notes that may have been added about the bid package. You can also 
add notes about the bid package from this tab.

 l Documents Tab: Displays a list of all attached documents. You can attach documents to the bid 
package from this tab as well.

 l Forms Tab: Lists all forms that have been attached to this bid package. You can attach or remove 
forms from the bid package using this tab as well.

 l Processes Tab: Lists all attached processes. You can attach or remove processes from the bid 
package using this tab as well.

Related Topics:
 l Additional Actions in the Bidding Module

Bid Scope
Use the Bid Scope tab to define the scope of the bid for potential bidders. Once the scope is defined, bidders 
will need to provide the standard information you ask for and submit it in the format you need. This feature is 
most useful when there are multiple items to compare across the potential bidders. Having data in a common 
format simplifies this comparison process and ensures data quality and compliance standards are met.

Note: The Bid Scope tab will be displayed only if bid tabulation has been enabled in the account setup. 
Contact your e-Builder account administrator if you need access to this feature.

To access the Bid Packages page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

bidding_custom_fields.htm
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 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

Submit Quote Mode

For bid packages that are used for pre-qualification purposes or cases where the bid manager has a spe-
cific form that bidders need to complete and submit, the Submit Quote mode may be used. 

Bid managers may use the Submit Quote mode when they have a preliminary qualifications round for short-
listing the package and then a separate financial bid. If the bid manager has a very specific bid form to be 
downloaded and filled out, the Submit Quote mode may also be appropriate. 

 l In this situation, the bid manager does not set up any sections or line items on the Bid Scope tab.  By 
not having Bid Scope line items, the package defaults to the Submit Quote mode because no fin-
ancial data will be input into the Bid Response.  

 l On the Bid Response tab of the Bid Portal, the bidder will only see a button to upload their response 
document. 

Note: Only one document is allowed to be uploaded.

 l If the bidder needs to submit a revised quote prior to the bid deadline, use the Submit Quote button 
and re-upload a new document.  

Note: The Recall Bid function is not available in this type of bid package.

 l After the bid package deadline, the Bid Tabulation tab is not activated since there are no financial 
numbers or responses from the bidders to compare.

Bid Scope Creation

To simplify the process of creating a bid scope, you can import the data from a file, use a bid scope tem-
plate or copy the bid scope from an existing project. 

If you wish to create your own file or template, the e-Builder field names are listed below. 
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Tip: Although these are the default fields, every field does not have to be used. Custom fields can also be 
created to accommodate your needs. Please contact your e-Builder Administrator if you require custom 
fields.

Note: If you are not using the template, please be advised that the spreadsheet file you are importing 
must have a defined header row for a successful import. The first row in the spreadsheet (highlighted in 
red below) should have the names of the columns you want to import.

Import Bid Scope

If the column headers in your import document do not match the field labels within e-Builder, you will have 
to manually map each column to the associated e-Builder field. 

If your import file column headers match the e-Builder field names, you can import your data without having 
to complete any field mapping. A template containing these column headers can be downloaded from e-
Builder. 

To import a bid scope
 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.
 3. Click Import Bid Scope.

The Import Bid Scope Items - Select Import File page is displayed.
 4. In the Select How to Import Scope Items section, choose one of the following options:

 o Add new bid items: Select this option to add the import items as new bid items.
 o Add new and update existing bid items: Select this option to add new import items as 

well as update items that are already in the bid scope.
 o Overwrite existing bid items: Select this option to use the import items to overwrite exist-

ing bid scope items.
 5. In the Import File field, click Choose File to search for and attach an MS Excel import file (.xls or 

.xlsx format).

Tip: Click the Download Import Template link to download a template from e-Builder that you 
can use.

 6. Click Next.
The Import Bid Scope Items - Field Mappings page is displayed.
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 7. To change any of the field mapping options, click the respective drop-down lists and make your 
selections.

 8. Click Next.
The Import Bid Scope Items - Review page is displayed, allowing you to preview the fields of the 
bid scope.

Note: If there are any exceptions, they are listed on the Exceptions tab. Click the Exceptions 
tab to review errors. Go back to the MS Excel file and make any necessary corrections, and 
then repeat the import procedure.

 9. Click Import.
A successful import confirmation is displayed.

 10. Click Finish.

Apply a Bid Scope Template

Bid scope templates are created and made available by account administrators.  Instead of manually cre-
ating the bid scope, you can apply a bid scope template or copy a bid scope from an existing project.

Users with Manage Templates permissions can perform these actions.

To apply a bid scope template or copy the bid scope from an existing project
 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.
 3. Click Apply Template.

The Apply Bid Scope Template dialog box is displayed.

 4. To apply a bid scope template, select the Bid Scope Template option and then select the tem-
plate from the Template drop-down menu.
—Or—

 5. To copy the bid scope from an existing project, select the Project Bid Package option. Select 
the Project from the Project drop-down menu, and then select the bid package from the Bid 
Package drop-down menu.

 6. Click Apply.

Additional Actions

Create Sections in the Bid Scope

Create sections in the bid scope to itemize and separate the different areas of the scope; such as general 
conditions and other fees, base bid, and alternates. This makes it easier for bidders to submit their bids and 
having a standard format simplifies the process of reviewing bids as well.

To create a section in the bid scope
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 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.
 3. Click Create Section.

The Add Bid Section popup window is displayed

 4. Enter the following information and complete all necessary fields:
 o Name: Enter the name of the section. This is a required field.
 o Type: The Base Bid is the main section to collect the bids and is required in all bid scope 

definitions. Choose Alternate for all other sections. This is a required field.
 o Include Cost Per SqFt: If square footage was entered in the bid details, selecting this 

check box will allow the system to calculate the square footage per bid scope item in the 
bid tabulation. If this check box is selected, you are also able to filter by square footage on 
the Bid Tabulation tab.

 o Include Percent of Base Bid: This option is directly related to bid tabulation. Select this 
check box to enable the display percent of base bid total  option located on the Bid Tab-
ulation tab.

 o Include Percent of Section: This option is directly related to bid tabulation. Select this 
check box to enable the display percent of section name  option located on the Bid Tab-
ulation tab.

 5. Click Save.

Add Items to Sections

Items can only be added to a section after the section has been created

To make an item "unit cost", the Bid Manager has to provide the details in the Quantity and the Unit of Meas-
ure (UoM) fields. The bidder then submits a "unit rate" against that quantity. If the Bid Manager fills in the 
Estimate/ Unit Cost field details on a unit cost item, that rate is saved for reference and only the Bid Man-
ager will be able to see it. This is useful for later comparison on the Bid tab. If the Bid Manager fills in the 
Estimate/ Unit Cost field details on a lump sum item, that amount is saved for the Bid Manager's reference 
as well.

To add items to bid scope sections
 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.
 3. Click Add Item located in the respective section. 

The Add Bid Item popup window is displayed.
 4. Complete all required fields (marked with an *):

 o Bid Section: The bid scope section that the item is created in. This field is not editable.
 o Item Number*: Enter or select the item number in this field.
 o Short Description*: Enter a description for the bid item.
 o Spec Reference: Enter the specification reference number for the item.
 o Part Number: Enter the part number for the item.
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 o Quantity: Enter a quantity for the item. 
 o UoM: Select a unit of measure from the drop-down list for the quantity entered. 

Note: When entering the quantity, the unit of measurement is a required field.

 o Estimate/ Unit Cost: Enter an estimate of the cost per unit of the item. If a non-zero 
quantity is entered, this amount is the estimated unit cost else it is the total estimate and 
no unit cost information will be saved.

 o Budget Line Item: Select a budget line item. This field is displayed only when "Bid Award 
to Commitment" is turned on under Bid Options.

 o Construction Code: Select the construction code for the item from the drop-down list. 
This field is displayed only when construction codes are managed. 

 o Details: Enter a description of the item and provide more details about it.
 5. Click Save. The popup window remains open, allowing you to add additional line items by repeat-

ing the previous steps.
 6. When you are done adding items, click Cancel to close the popup window.

Add a Formula

Formulas can be created to add different sections together so that you can look at the bid submissions in dif-
ferent ways. 

For example, base bid + alternate 1, or base bid + alternate 1 and alternate 2. 

Note: These formula results are not shown to the bidders, only to the bid manager when the bid tab-
ulation is opened.

To add a formula
 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.
 3. Toward the bottom of the page, click Add Formula.

The Add formula dialog is displayed.

 4. Enter the name of the formula in the Name field.
 5. Select the check box next to the section(s) you want to include in your formula.
 6. Click Save.

The totals are displayed at the bottom of the page, in the Bid Summary section.

Export the Bid Scope

The bid scope can be exported to an MS Excel spreadsheet enabling you to share pertinent bid scope 
estimations with others who may not have access to e-Builder Enterprise or the Bidding module.

To export the bid scope to an Excel spreadsheet

bidding _settings_ options.htm
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 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.

 3. Click the export to Excel icon ( ).
The MS Excel spreadsheet is downloaded.

Add Additional Information

The Additional Information feature allows you to capture and track pertinent data about potential bidders to 
help you make the best and most informed decision. You can choose to add questions that you require 
potential bidders to answer, include relevant data that potential bidders cannot see, use the data for bid tab-
ulation, or all of the above.

Individual additional information records can be added one at a time or you can add records that have been 
used in different projects.

To add an additional information record
 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.
 3. Click the Additional Information tab.
 4. In the Prompt/Question field, enter the prompt or question.
 5. Select all check boxes that apply:

 o Bidder Entry: Select this check box to allow the prompt/question to be visible for bidders 
to fill out.

 o Required: Select this check box to make the prompt/question a required field for bidders 
to complete. If you select this check box, the Bidder Entry check box will also be selected 
by default.

 o Include in Bid Tabulation: Select this check box to include the prompt/question in the 
bid tabulation. This facilitates comparing bidders based on the additional information 
entered.

 6. Click Save.

To add an additional information record from a project
 1. Go to the Bid Package Details page.
 2. Click the Additional Information tab.
 3. To include records used in a particular project, click Add From Project.

The Add Additional Information window is displayed.

 4. From the Project drop-down list, select the project from which the additional information records 
will be copied.

 5. Select a bid package from the list of project results.
 6. Select the check box next to the question/ prompt you want to add.
 7. Click Add.
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 8. Click Close to return to the Additional Information tab.

Add Addenda

When there is a change to the bid scope, adding an addendum is a fast and easy way to get the information 
to all parties at once. Bidders receive an email notification when an addendum is issued. When they log into 
the portal, they can review the text of the addendum under the Package Invitation/ Addenda tab. Prior to 
submitting a response, the bidder is required to acknowledge every issued addendum with a check box on 
the STEP 3: Additional Required Info tab.

Note: An addendum can only be added after an invitation to bid has been sent out but new addenda can-
not be added after the bid tabulations has been opened. Addenda notifications are sent out to all invited 
bidders, irrespective of whether they have responded to the invitation to bid or not. If the bidder already 
submitted their bid after the addendum was issued, the bidder will receive notification requiring them to 
resubmit their bid and acknowledge the addendum.

The addendum is text-only. If new documents are issued as a result of the addendum, add a new folder 
inside the designated Bid Documents folder as a best practice. The bidders will see this folder on the portal 
in the Invitation Documents tab.

To add an addendum
 1. Go to the Bid Package Details page.
 2. Click the Bid Scope tab.
 3. Click the Addenda tab.
 4. Click Add Addendum.

The Add Addendum for Bid Package popup window is displayed.

 5. Enter the following information:
 o Addendum Number: Enter a number for the addendum. 
 o Description: Enter a description for the addendum.
 o Details: Enter the details of the addendum. This is optional.
 o Documentation Available Date: Enter or select the date and time at which the details of 

the addendum will be available for bidders to view. This is optional.
 6. Click Save.

Available on the Bid Scope page

Fields
 l Project: Displays the project name.
 l Bid Package: Displays the name of the bid package.
 l Project Number: If available, the project number is displayed in this field. Project numbers allow 

you to have a unique identifier for each of your projects. Account administrators can add project num-
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bers by going to Administration Tools > Projects > Project Settings > Choose a custom field option 
from the Project Number Custom Field drop-down menu.

 l Status: Displays whether the bid package is open or has been closed.

Tabs

The following tabs are available on the Bid Scope page:

Scope Tab
 l Create Section: Click to create the different sections of the bid scope. Creating sections helps 

you itemize the bid scope, clearly separating the different areas of scope; such as general con-
ditions and other fees, base bid, and alternates. This makes it easier for bidders to submit their 
bids and having a standard format simplifies the process of reviewing bids as well. 
This button is only available prior to sending out the invitation to bid. Once the invitation has been 
sent this button will disappear. To make changes after this point, you will have to create an 
addenda.

 l Add Item: One of these buttons is displayed for all sections that have been created. Click to add 
the details of the individual items that contractors will bid on. 
This button is only available prior to sending out the invitation to bid. Once the invitation has been 
sent this button will disappear. To make changes after this point, you will have to create an 
addenda.

 l Base Bid: The Base Bid is completed by bid managers when creating the sections of the bid 
scope. This is the only required section of the bid scope. When the quantities and prices to com-
plete the project have been estimated, the bid manager uploads these figures to use as a com-
parison when potential bidders begin to submit their figures.

 l Add Formula: Click to add formulas, which allows you to add different sections of the bid scope 
together so that you can look at the bid submissions in different ways. For example, base bid + 
alternate 1, or base bid + alternate 1 and alternate 2. These formula results are not shown to the 
bidders, only to the bid manager when the bid tabulation is opened.

 l Bid Summary: This section of the bid scope will auto-populate a summary of the totals in all pre-
vious sections of the bid scope.

Additional Information Tab

The additional information tab allows you to capture and track pertinent data about potential bidders to 
help you make the best and most informed decision. You are able to choose which of the sets of inform-
ation is visible to potential bidders and which will be hidden from their view. You can choose to add ques-
tions that you require potential bidders to answer, include relevant data that potential bidders cannot 
see, use the data for bid tabulation, or all of the above.

 l Add From Project: Click to pull in questions/ responses from another package on any project to 
avoid having to re-enter the same information with every bid package.

 l Question/ Prompt: Displays after additional information has been added. This column lists the 
questions or additional information that you're tracking or want potential bidders to complete.
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 l Bidder Entry: Displays after additional information has been added. A check mark in this column 
indicates that the question/ prompt is visible to potential bidders.

 l Required: Displays after additional information has been added. A check mark in this column 
indicates that the question/ prompt is a required field for potential bidders to complete.

 l Include in Bid Tabulation: Displays after additional information has been added. A check mark 
in this column indicates that the question/ prompt will be included in the bid tabulation. 

 l Add Additional Information: Use this section to quickly add additional information records.
 o Prompt/ Question: Enter the questions or prompt in this field.
 o Bidder Entry: Select this check box to allow the prompt/ question to be visible for bidders 

to fill out.
 o Required: Select this check box to make the prompt/ question a required field for bidder 

to fill out.
 o Include in Bid Tabulation: Select this check box to include the prompt/ question in the 

bid tabulation. This facilitates comparing bidders based on additional information.
 l Save: Click to save the new additional information record.

Addenda Tab

When there is a change to the bid scope, adding an addendum is a fast and easy way to get the inform-
ation to all parties at once. When bidders log into the bidder portal, they will be able to view and acknow-
ledge that they have seen all addenda items.

Note: An addendum can only be added after an invitation to bid has been sent out, but new addenda 
cannot be added after the bid tabulation has been opened.

 l Add Addendum: Click to add an addendum. This button will only be visible after an invitation to 
bid has been sent out, and before the bid tabulation has been opened.

 l Addendum Number: Each time an addendum is added, you must assign a number to it. That 
number displays in this column.

 l Description: Displays the description of the addendum.

 l Date Created: Displays the date the addendum was created.

 l Documentation Available Date: Displays the date that the details of the addendum will be avail-
able for bidders to view.

Related Topics:
 l Additional Actions in the Bidding Module

Potential Bidders
Bidders who may be good candidates to bid on a project can be added to the potential bidder list. 

Use the Potential Bidders tab as a staging area to build out a list of potential bidders without actually inviting 
them to bid.
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Depending on the permission assignment, the following tasks can be completed by either:
 l Pre-construction Managers
 l Estimating Coordinators

To access the Bid Packages page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

Add Potential Bidders

Potential bidders can be selected from your contacts or from a previous project. Only e-Builder contacts 
can be invited to the bidders list. Only contacts with an email address or fax can be added, otherwise, they 
will not be displayed on the Contacts Filter. 

If you assigned codes on the bid package, then you will only be able to invite those whose company has 
assigned to them at least one of the codes configured in the bid package.

Note: You will not be able to assign CSI codes to this bid package once a bidder has been added / 
invited.

To add bidders from contacts
 1. Go to the Bid Package Details page.
 2. Click the Potential Bidders tab.
 3. Click Add.

The Filter Contacts popup window displays.

 4. Enter any pertinent information that will help you find the contact.

Note: The least amount of information entered renders the most results. The more specific 
information you enter, the narrower your results will be.

Tip
To see a list of all available contacts, do not add any information at all, just click Filter.

 5. Click Filter.
Results display in the Contacts section toward the bottom of the window.

 6. Select the check box next to the contact(s) you want to add.
 7. Click Insert Selected.
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In order to save time and resources, you can add bidders that were previously invited on another or similar 
bid project. This feature mines the e-Builder database locating good potential bidders, based on their past 
project experience.

Note: You will not be able to assign CSI codes to the bid package once a bidder has been added / 
invited.

To add bidders from a previous project
 1. Go to the Bid Package Details page.
 2. Click the Potential Bidders tab.
 3. Click Add From Project.

The Add Potential Bidders from [Project] page is displayed.

 4. Enter all required fields.
 5. Click Filter.

A list of bidders that meet the filter criteria is displayed.

 6. Click the check box next to the bidders you want to add.
 7. Click Add.

Invite Potential Bidders

Before potential bidders can be invited to bid, they must first be added.

Once the invitations are sent, potential bidders that are invited using the Potential Bidders tab will auto-
matically be added to the Invited Bidders Tab.

Note: If contacts are assigned to construction codes, and a potential bidder is invited on a particular 
code, the contact is removed from only that code. If the contact is a potential bidder on another code, that 
contact will still appear in this list. If the potential bidder is invited on all codes, they will be removed from 
this list.

To invite potential bidders
 1. Go to the Bid Package Details page.
 2. Click the Potential Bidders tab.
 3. Select the check box next to the potential bidders you want to invite.
 4. Click Invite.

The Invite Bidders page is displayed.

 5. Take any of the following actions on the Invite Bidders page:
 o Enter a message
 o Add/ Remove additional contacts

 6. Click Send.

Remove Bidders from Potential Bidders List
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If a bidder was included by mistake, you can remove them from the list. Each bidder has a bidder history, 
and if you delete a potential bidder, they are removed from the list and there will be no historical record that 
the bidder participated on the project.

Note: If you are managing users by construction codes, deleting the user will remove them completely 
from all construction codes. You can also disassociate a bidder from a specific code by deleting just that 
code located under the bidder's name (Bidder View).

To delete a potential bidder
 1. Go to the Bid Package Details page.
 2. Click the Potential Bidders tab.
 3. If you are using construction codes to manage bidders, ensure that you are in the Bidder's View 

by selecting Bidders from the Show drop-down list.
 4. Select the check box next to the potential bidder's name.
 5. Click Delete.
 6. Click OK.

To remove a specific construction code for a bidder
 1. Go to the Bid Package Details page.
 2. Click the Potential Bidders tab.
 3. Ensure that you are in the Bidder's View by selecting Bidders from the Show drop-down arrow.
 4. Click the plus sign next to the potential bidder to view all associated construction codes.
 5. Select the check box next to the construction code(s) you want to remove.
 6. Click Delete.
 7. Click OK.

Print Potential Bidders List

Use the Print feature on the Potential Bidders tab to print out a list of potential bidders to use.

To print a list of potential bidders
 1. Go to the Bid Package Details page.
 2. Click the Potential Bidders tab.
 3. Click Print.

Reopen Bid Packages

If a bid package is closed and you have modify bidding permissions, then you can always reopen the pack-
age at any time. This feature prevents the project bid from being locked down when it is closed.

To reopen a bid package
 1. Go to the Bid Package Details page.
 2. Click the Potential Bidders tab.
 3. Click Re-open.
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Potential Bidders Tab Details

Fields
 l Project: The name of the project.
 l Bid Package: The name of the bid package.
 l Project Number: If available, the project number is displayed in this field. Project numbers allow 

you to have a unique identifier for each of your projects. Account administrators can add project num-
bers by going to Administration Tools > Projects > Project Settings > Choose a custom field option 
from the Project Number Custom Field drop-down menu.

 l Status: The status of the bid package (open or closed).

Additional Actions
 l Show Notes: Select this check box to view notes directly on the table for each respective contact.

Switch Views

If you chose to use construction codes to identify bidders, you can access two different views - the Bidders 
view and the Construction Codes view. These views are available on the Potential Bidders tab and the 
Invited Bidders tab. 

To switch between the views click the Show drop-down arrow.
 l Bidders View: The bidders view displays each potential/ invited bidder, their company name, contact 

person, email, fax, phone number and the date their contact information was entered into e-Builder. 
If construction codes were used to categorize your contacts, click the expand button under each con-
tact to view all associated divisions and construction codes.

 l Construction Codes View: The Construction Codes View is only available if you've managed bidders 
by construction codes. The construction codes view displays a list of construction codes assigned to 
the project, grouped by division, with the number of potential/ invited bidders associated with each 
division in the column on the right.

Invite Bidders Page Details

This page can be accessed by clicking the Invite button on the Potential Bidders tab on the Bid Package 
Details page.

Fields
 l Project: The name of the project.
 l Project Number: If available, the project number is displayed in this field. 
 l Subject: The subject of the invitation message.
 l Message: The message body of the invitation.
 l Selected Bidders: The contacts who have been selected to receive the invitation.
 l Custom Fields: When available, this section includes the custom fields set up by Administrators 

under Invitation Custom Fields.

bidding_custom_fields.htm
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Related Topics:
 l Invited Bidders Tab
 l Additional Actions in the Bidding Module

Invited Bidders
The Invited Bidders tab displays a list of all who have been invited to bid on the project.

Depending on the permission assignment, the following tasks can be completed by either:
 l Pre-construction Managers

 l Estimating Coordinators

To access the Bid Packages page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

Invite Additional Bidders

Use the Invite feature to send out invitations to bid to new contacts (not already included in the invited bid-
ders grid), or to add additional codes to existing invited bidders. Once you send the invitation to bid, all con-
tacts selected will be included in the Invited Bidders List.

The bidding instructions document will be attached to the email  with the invitation.

Note: If you are using the construction codes feature to identify bidders, the companies' construction 
codes must match those assigned to the project for contact to show up on the filter.

To invite additional bidders
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.
 3. Click Invite.

The Invite Bidders page is displayed.

 4. Enter or modify the subject of the invitation mail in the Subject field.
 5. Enter an optional message to the bidders in the Message field.
 6. Click Add Contact or Remove Contact to add or remove additional contacts. 
 7. Click Send.
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Re-invite Bidders

Use the Re- invite feature to resend the invitation to bid to a contact who may have misplaced the invitation 
or may not have responded to the previous invitation.

To re-invite bidders
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.
 3. Select the check box next to the bidder(s) you want to re-invite.
 4. Click Re-invite.

The Invite Bidders page is displayed.
 5. Enter or modify the subject of the invitation mail in the Subject field.
 6. Enter an optional message to the bidders in the Message field.
 7. Click Add Contact or Remove Contact to add or remove additional contacts. 
 8. Click Send.

Update Bid Status

If you are viewing the list of invited bidders using Bidders View, you can update the status of bidders manu-
ally. It is important to clarify that e-Builder automatically updates the bid status of each invited bidder based 
on their responses via the bidder portal. The status is set to Pending when an invitation has been sent but 
no response has been received. Once an invited bidder responds electronically, ( Will bid or Will not bid ) 
the status is updated accordingly. You also have the option of manually updating the bidder's status.

To manually update the bid status
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.
 3. In the Invited Bidders table, click the drop-down lists under the Bid Submitted and Status 

columns to manually change each status.

Print Invited Bidders List

Use the Print feature on the Invited Bidders tab to print out a list of potential bidders to use.

To print the invited bidders list
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.
 3. Click Print.

Export Invited Bidders List to Excel®

Exporting bid coverage information is useful for bid analysis purposes. This is a handy feature that allows 
you to include data for use in external financial reports. The export feature allows you to avoid manual data 
entry and export right from e-Builder into Excel.
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To export the Invited Bidders List to Microsoft Excel®
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.

 3. Click the Export to Excel icon  .

Award Bidders

Use the Award feature to simultaneously send a bid award notification to the winning bidder and noti-
fications to other bidders who have submitted a bid response. 

Note: If the Bid Award to Commitment feature has been activated on the Bid Options page (Setup > Bid-
ding > Options), then the designated commitment process can also be initiated when the bid is awarded.

Tip: If the incorrect bidder was selected, select the Undo Award option to rescind the bid award. Note 
that messages that were already sent cannot be retracted.

To award a bidder
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.

 3. Click the  button beside the bidder you want to award.

 4. Select the Award option from the Bidder Options popup menu.
The Award Notification window is displayed.

 5. Select the Send message to the winning bidder check box and enter or modify the message 
to the winning bidder in the Message field.

 6. Select the Send message to the other bidders check box and enter or modify the message to 
the other bidders in the Message field.

 7. Click Send.

Note: If the Bid Award to Commitment feature was activated, the Send and Initialize Com-
mitment Process button will be displayed on this page. Use this button to send the bid award 
notification message and initiate the commitment process.

Revoke Invitation to Bid

Use the Revoke feature to prevent a bidder from participating in the bid but continue to keep them in the 
Invited Bidders list for historical purposes.

To revoke an invitation to a bidder
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.

 3. Click the  button beside the bidder invitation you want to revoke.

 4. Select the Revoke option from the Bidder Options popup menu.

bidding _settings_ options.htm
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 5. In the popup that is displayed, select OK to confirm the action. 

Tip: If the incorrect bidder was selected, select the Restore option from the Bidder Options 
popup menu to undo the revocation.

Delete Invitation to Bid

Use the Delete feature to remove the bidder entirely from the bid and the Invited Bidders list. When this fea-
ture is used, the bidder will not be tracked in the bid history either. A bid manager will most likely delete a 
bidder only if they were accidentally invited.

To delete an invitation to a bidder
 1. Go to the Bid Package Details page.
 2. Click the Invited Bidders tab.

 3. Click the  button beside the bidder invitation you want to delete.

 4. Select the Delete option from the Bidder Options popup menu.
 5. In the popup that is displayed, select OK to confirm the action. 

Invited Bidders Tab Details

Fields
 l Project: The name of the project.
 l Bid Package: The name of the bid package.
 l Project Number: If available, the project number is displayed in this field. Project numbers allow 

you to have a unique identifier for each of your projects. Account administrators can add project num-
bers by going to Administration Tools > Projects > Project Settings > Choose a custom field option 
from the Project Number Custom Field drop-down menu.

 l Status: The status of the bid package (open or closed).

Additional Actions
 l Show Notes: Select this check box to view notes directly on the table for each respective contact.

 l  :Click the Notes button to add or view notes for the contact such as call logs.

 l Contact: Click the contact name to view the invitation details for that contact.
 l Status: Click this drop-down list and manually change the status of the construction code or bidder 

(if construction codes were not used). 

Note: e-Builder automatically updates the bid status of each invited bidder based on their Accept 
or Decline response via the bidder portal. The status is set to Pending when an invitation has been 
sent but no response has been received. Once an invited bidder accepts or declines elec-
tronically, the status is updated to Will Bid or Will Not Bid.

 l Bid Submitted: Select whether the bid was submitted or not.
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 l Show: If you chose to use construction codes to identify bidders, you can access two different views 
from this drop-down menu:

 o  Bidders View: Choose this view in order to view the list of invited bidders by company name 
and contact information. If there are construction codes associated with the contact, expand-
ing the contact will display the associated construction code(s).

 o Construction Codes View: Choose this view to see a list of construction codes. The # 
Invited column will allow you to see how many bidders are on the invited list from each divi-
sion. Expanding the division will display the associated contact(s).

Invite Bidders Page Details

This page can be accessed by clicking the Invite button on the Invited Bidders tab on the Bid Package Details 
page.

Fields
 l Project: The name of the project.
 l Project Number: If available, the project number is displayed in this field. 
 l Subject: The subject of the invitation message.
 l Message: The message body of the invitation.
 l Selected Bidders: The contacts who have been selected to receive the invitation.
 l Custom Fields: When available, this section includes the custom fields set up by Administrators 

under Invitation Custom Fields.

Switch Views

If you chose to use construction codes to identify bidders, you can access two different views - the Bidders 
view and the Construction Codes view.

These views are available on the Potential Bidders tab and the Invited Bidders tab. To switch between the 
views click the Show drop-down arrow.

Bidders View

The bidders view displays each potential/ invited bidder, their company name, contact person, email, 
phone number and the date their contact information was entered into e-Builder. If construction codes were 
used to categorize your contacts, click the expand button under each contact to view all associated divi-
sions and construction codes.

Bidders View Fields
 l (Notes Icon): Click to add a note to the invited bidder's record. You're able to see all added 

notes by expanding the bidder's record.
 l Company: This column displays the name of the company that the invited bidder belongs to.
 l Contact: This column displays the invited bidder's name.
 l Email: This column displays the invited bidder's email address.

bidding_custom_fields.htm
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 l Phone: This column displays the invited bidder's phone number.
 l Bid Submitted: This column displays whether or not the bid has been submitted.

 l  (Bidder Options Icon): The Bidder Options icon ( ) allows you to take any of the following 
actions:

 o Re-Invite: Select this option to resend an invitation to bid.
 o Revoke: Select this option to remove the bidder from participating in the bid but keep 

them in the invited bidder list for historical purposes.
 o Award: Select this option to award the bid.
 o Delete: Select this option to remove the bidder entirely from the bid  no history will be 

tracked. A bid manager most likely will only delete a bidder in the event that they were acci-
dentally invited.

 o Submit Bid: Select this option to submit the bid.
 o Undo Award: Select this option rescind an award.

 l  (Update Status Icon): Click this icon to update the bidding status of all construction divi-
sions associated with a single bidder.

Construction Codes View

The Construction Codes View is only available if you've managed bidders by construction codes. For more 
information, see Manage Construction Codes. The construction codes view displays a list of construction 
codes assigned to the project, grouped by division, with the number of potential/ invited bidders associated 
with each division in the column on the right.

Construction Codes View Fields
 l Code: This column lists all available construction codes. Expanding the division will display the 

associated contact(s).

 l # Invited: This column displays the number of bidders that have been invited to bid from each 
division. The Status drop-down menu is editable, so you're able to update the status of each per-
son's invitation manually, but it is important to note that e-Builder automatically updates the bid 
status of each invited bidder based on their responses via the bidder portal. The status is set to 
Pending when an invitation has been sent but no response has been received. Once an invited 
bidder responds electronically, ('Will bid or Will not bid') the status is updated accordingly.

 l # Pending: This column displays the number of invited bidders whose invitation to bid is 
pending. This status is automatically applied by e-Builder if an invitation has been sent but no 
response has been received. When the division is expanded, the Response field is editable and 
allows you to update the response to Yes or No.

 l # Declined: This column displays the number of invited bidders who have declined to bid.

 l # Accepted: This column displays the number of invited bidders who have accepted the invit-
ation to bid.
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 l # Bids: This column displays the number of bids the invited bidder was invited to.

 l # Awarded: This column displays the number of bids the invited bidder has been awarded. The 
award icon provides a visual indication of the bidder's awarded status.

Related Topics:
 l Additional Actions in the Bidding Module

Bid Documents
The Bid Documents tab displays all the folders and files that the invited bidders have access to. On the Bid 
Documents tab, the bid manager can check whether the bid details are set properly for the bidders to view 
when they get invited and login to the Bidder's Portal.

When you create a bid package or edit the bid details, you have to select a Bid Documents Folder. This Bid 
Documents Folder  is mapped to your Trimble Unity Construct Documents repository.

Note: Any sub folders and files created in the mapped folder are also accessible by the invited bidders. 

To access the Bid Packages page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

View and Download Bidding Documents

As a bid contact, you have the ability to view and download documents that your bidders can access.

To view bidding documents
 1. Go to the Bid Package Details page.
 2. Click the Bid Documents tab.

All the folders and files that invited bidders have access to are displayed.

 3. Navigate to the required file and then click the file to view it.

To download bidding documents
 1. Go to the Bid Package Details page.
 2. Click the Bid Documents tab.

All the folders and files that invited bidders have access to are displayed.
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 3. Navigate to the required file and then select the check box next to the file.

Note: You must select at least one file to download.

 4. Click Download.

Display History of Invited Bidders

The Bid Documents Access History page displays the history of all the invited bidders' activity within the Bid 
Documents folders. For example, if a user from a company viewed an architectural file, then a row will be 
inserted in the table with a date and time stamp of this action. If the user downloaded the document, this will 
also be shown. 

Using this page, the Estimating Coordinator or Manager will be able to determine who has viewed, down-
loaded, ordered or picked up prints and can use this information to equip the estimating team with a firm 
understanding of recent activity.

To display the history of invited bidders' activity
 1. Go to the Bid Package Details page.
 2. Click the Bid Documents tab.
 3. Click History.

The Bid Documents Access History page is displayed with all the available access history 
records for the Bid Documents.

Tip: Use the Filter section to narrow down the results.

Related Topics:
 l Additional Actions in the Bidding Module
 l Assistance for Invited Bidders

Questions/Responses
Bid contacts can use the Questions/ Responses tab to share questions and communicate responses to the bid-
ders. All inquiries and responses posted here are sent to all bidders via email. This eliminates the need to send 
multiple emails, and is a great way to broadcast information that is useful to all the bidders. 

To access the Bid Package Details page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.



Trimble Unity Construct

Page 35

Add Questions

The Questions/ Responses tab displays questions submitted by bidders or users and allows the Bid 
Contact to post answers either publicly or directly to the bidder. 

To add questions
 1. Go to the Bid Package Details page.
 2. Click the Questions/Responses tab.
 3. Click Add Question.

The Bidder Question popup window is displayed.
 4. Complete the following required fields:

 o Subject: Enter a subject for the question
 o Question: Enter the question.
 o Response: Add a response to the question.
 o Send response to all bidders?: Select this check box to allow all bidders to view your 

response.
 5. Click Save.

Respond to Bidder Questions

Questions posted by bidders in the Bidder's Portal will be displayed on the Questions/ Responses tab in e-
Builder. A message will also be displayed, indicating the number of questions awaiting responses. 

You can answer the bidders question and make the response publicly visible to all bidders or answer the 
bidder directly.

Note: Only the Bid Contact or users with Modify Bidding permissions can respond to bidder questions.

To respond to a bidder's question
 1. Go to the Bid Package Details page.
 2. Click the Questions/Responses tab.
 3. Click a question to view it.
 4. Enter your response in the responses field.
 5. Select the Send the response to all bidders check box to allow all bidders to view your 

response.
—Or—
Leave this check box unselected to send the response only to the user who asked the question.

 6. Click Reply.

Export Questions and Responses

Use the export feature to export the questions and responses to your local machine. You can then share 
the relevant information to non e-Builder license holders, such as Architect/ Engineers and all other applic-
able parties if needed.
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The exported file will be in the MS Excel (.xls) format.

To export questions/ responses
 1. Go to the Bid Package Details page.
 2. Click the Questions/Responses tab.
 3. Click Export.
 4. To export only the unanswered questions, select the Only Unanswered check box in the Export 

Questions popup.
 5. Click Export Now.

Additional Actions
 l Show: Select any of the available options to filter the questions displayed in this section.

Related Topics:
 l Additional Actions in the Bidding Module

Bid Tabulation
The Bid Tabulation feature helps bid managers save a significant amount of time. You can focus more on bid 
analysis without having to arrange bid results side-by-side for comparison using multiple spreadsheets. The 
tabulation is updated instantly whenever a change is made on either the bid tabulation itself or if a change is 
made in the bidder portal. The bid tabulation provides a seamless and effortless way to keep the lines of com-
munication open between the bid manager and bidders.

Bid tabulation works in conjunction with bid scope. After your bid scope has been defined, you can tabulate the 
results of all submitted bids from the Bid Tabulation tab. Consequently, this tab is not functional until at least 
one bid has been submitted. By default, the bid tabulation can't be opened until after the bid due date, however 
there is a setting in the account setup that will enable the bid tabulation to be opened any time prior to the bid 
due date for all non-public projects. See Bidding Options for more information.

Upon bid submission, one folder will be created for each bid containing both bid submission custom field 
information and supporting documentation files. When the bid is submitted, the bid package supporting doc-
uments folder will not be visible in the Documents module until the bid tabulation has been opened.

Note: The Bid Tabulation tab is displayed only if bid tabulation has been enabled in the account setup. 
Contact your e-Builder account administrator if you need access to this feature.

There are a number of customizable features on the bid tabulation tab to meet the unique needs of your par-
ticular organization. For instance, you have the ability to adjust totals after negotiating with bidders. If your 
organization follows a public bid process, you can optionally turn off this capability by clearing the Allow 
Adjustments check box on the Add/Edit Bid Package Details Page. An additional account feature includes 
the option to require one or more witnesses present before the bid tabulation is opened.

To access the Bid Package Details page from the top navigation menu 

bidding _settings_ options.htm
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 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

Adjust Bidder's Values

If this setting is enabled in the bidding details, you are able to adjust the totals received by bidders. After the 
adjustment is made, the change is reflected in the bidder portal for the bidder to view. When the bidder logs 
into the bidder portal, adjusted amounts display in red and they are able to view your notes. If your organ-
ization follows a public bid process, you can optionally turn off the capability to adjust the totals.

To adjust values
 1. Go to the Bid Package Details page.
 2. Click the Bid Tabulation tab.
 3. Click the title of the bidder's company. 

The Invitation Details page is displayed.

 4. Click the Bid Details tab.
An Adjust link displays next to each Total Cost value.

 5. Click the Adjust link next to the total you want to change.
The Adjust Bid Amount popup window displays.

 6. Enter all required fields.
 7. Click Save.

Export Submitted Bid Data

Use the Export feature to download submitted bid data such as the base bid, bid summary and bidder qual-
ification notes. 

To export data
 1. Go to the Bid Package Details page.
 2. Click the Bid Tabulation tab.
 3. Click Export. 

The data is downloaded as an Excel® (.xls) spreadsheet.

Bid Tabulation Page
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Additional Actions
 l Show/Hide Filter Toggle: Click this toggle to show or hide all filter options and make more space 

on the page for you to view bid details.

 l Filters: Each check box is a filter option that allows you to see different data on the screen. After 
selecting check boxes, click Re-Run to see the results reflected in the table.

 l Export: Click this button to export data into an Excel® spreadsheet.

 l Re-Run: Click this button to refresh the page based on your selected filters. Simply selecting filter 
check boxes will not display the results in the table below. You have to click the Re-Run button for 
changes to display.

 l Company Name: The company name is a clickable link that will take you to the Invitation Details 
page, from which page you are able to adjust values, if this setting is available on the project.

 l Bid Totals: This row lists totals for your initial estimate and that of all bidders. This view allows you 
to easily see totals across the board to simplify the process of comparing bids.

Related Topics:
 l Additional Actions in the Bidding Module

Permissions 
The Permissions tab gives bid managers the opportunity to update permissions directly from the Bidding mod-
ule instead of having to go to the Setup area. From here you are able to update the permission for roles and 
individual users. 

Note: There are two sections on this page, one for updating role permissions and another for individual 
users. The same permission settings are available for each group of users.

To access the Bid Package Details page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

To modify permissions for roles or individual users
 1. Go to the Bid Package Details page.
 2. Click the Permissions tab.
 3. Use the Filter Roles and Users section to search for and select a specific role or individual user 

based on select criteria.
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Tip: Select the Admin Roles Only check box to filter for administrative roles only.

 4.  Select one or more check box to apply its permission setting to the role or user:
 o View Bidding: This permission setting gives individual users and users the ability to view an 

entire bid package.
 o Modify Bidding: This permission setting gives individual users and users the ability to 

modify bid package details.
 o View/ Open Bid Tabulation: This permission setting gives individual users and users the 

ability to view and open the bid tabulation.
 5. Click Save Changes.

Related Topics:
 l Additional Actions in the Bidding Module

Bid History 
Users with View Bidding permissions have the ability to view the bid history log. This makes every facet of the 
bid process transparent and facilitates a hassle-free auditing process. From the Bid History tab, you are able to 
see the exact changes of a modified bid package; when the package was created and closed; and a list of 
potential and invited bidders and their statues. A history of when the bid tabulation was opened and short listed 
bidders are also accessible from this page. 

To access the Bid Package Details page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

To view the bid history
 1. Go to the Bid Package Details page.
 2. Click on the Bid History tab to view it.
 3. The following fields are displayed:

 o Show Filter/ Hide Filter: The filter is hidden by default. Click the Show Filter link to use the 
inline filter to narrow down the logged bid history actions by user, task, action or description.

 o User: Displays the name of the user that took the action.
 o Date & Time: Displays the date and time the action was taken.
 o Task: Displays the general area in which the action was taken; for example, Invited Bidders, 

Potential Bidders or Bid Scope Addendum.
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 o Action: Displays the action that was taken.
 o Description: Displays a description of the action.

Related Topics:
 l Additional Actions in the Bidding Module

Additional Actions
The Bid Package Details page includes few standard buttons that are repeated on each tab, allowing you to 
perform some of the most common actions from anywhere in the Bidding module.

To access the Bid Package Details page from the top navigation menu 
 1. From the top navigation tabs, click the Bidding tab.

Tip: Use this method if you are not already working in a project.

 2. On the Bidding page, choose a project from the All Projects menu.

The Bid Packages page is displayed.

 3. Click the name of a bid package to view the Bid Package Details page.

Manage Construction Codes

After a bid package is created, the Manage Codes button is displayed by default. 

Construction codes are entered by your e-Builder Administrator. These construction codes can be 
assigned to potential bidders, allowing you to group bidders by construction codes (optional). This makes it 
easier to find and identify bidders, if their name or contact information is not readily available. 

If you do not manage construction codes by the time a potential bidder is invited to bid, the Manage Codes 
button and feature will no longer be available.

Note: The Manage Codes button is available on every tab of the Bid Package Details page. 

To manage construction codes
 1. Go to the Bid Package Details page.
 2. Click Manage Codes.

The Manage Construction Codes page is displayed with a list of available construction codes.

 3. Select the codes you want to add to the project and then click Add.
The selected construction code(s) display in the adjacent box.

 4. Click Save.

Close Bid Packages
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After the bidding process is completed and the bid has been awarded, the bid package can be closed. 
Once the project bid is closed, the status in the bid package details will change to closed. 

Closing the bid package revokes access to the bid package for all invited bidders except for the awarded 
bidder. When the bid package is closed, bidders who have not been awarded will no longer see the bid 
package listed when they log into the Bidder Portal. Once the award has been granted, the awarded bidder 
can potentially be added as a licensed e-Builder user.

Once closed, the bid package can be reopened at a later date if necessary.

This task can be completed by:
 l Pre-construction Managers
 l Estimating Coordinators

Note: The Close button is available on every tab of the Bid Package Details page. 

To close a bid package
 1. Go to the Bid Package Details page.
 2. Click Close.
 3. Click Yes, Close the Bidding to confirm the action.

Send Messages

Sending a message allows you to broadcast a message to all project bid participants. This feature is espe-
cially useful when there is an addendum or if you're answering a question that you'd like to share with all 
Invited Bidders simultaneously. Your company's logo, as saved in e-Builder will automatically be included 
in all sent messages.

The send message feature is available throughout the Bidding module, on every tab of the Bid Package 
Details page. 

To send a message to bidders
 1. Go to the Bid Package Details page.
 2. Click Send Message.
 3. Enter the subject of the message in the Subject field.
 4. Enter your message in the Message field.
 5. In the Bidders Selected section, you can take any of the following actions:

 o To send the message to all invited bidders: Click Add All Invited. Proceed to the next 
step of adding files if required.

 o To send the message to certain contacts: Click Add to make your selection(s). The 
Lookup dialog box is displayed.

 a. Filter the contact information as required.

Tip
 l To send the message to just those bidders that expressed an interest in the pro-

ject, in the Bidding Status section, check only the Pending and Will Bid 
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check boxes and then click Filter.
 l To see all available contacts, do not enter any contact information, and just click 

Filter.

 b. Select the check box next to the contact(s) you wish to add.
 c. Click Insert Selected to add the contacts and return to the Send Message To Bid-

ders page.
 6. To attach files, click either Browse e-Builder or Browse Computer in the Attach File section.
 7. Click Send.

View Message History

Use the Message History feature to view a list of all outbound messages, including invitations to bid and 
other messages. This feature is available throughout the Bidding module, on every tab of the Bid Package 
Details page as well.

To view the message history
 1. Go to the Bid Package Details page.
 2. Click Message History. 

The Message History page  is displayed.
 3. In the Messages section, click the subject of a message to view it. 

The Message Details page is displayed. The Message Body tab is displayed by default and 
shows the message that was sent.

 4. Click the Delivery Status tab to view the status of each message per recipient.

Process Pending Requests

When applicable, the Pending Requests link is displayed in the upper right corner of the Bid Package 
Details page. Accessing pending requests allows administrators, bid managers and bid contacts to process 
a bidder's request to bid on a project or to reopen a project bid. 

Access requests are generated by those within the bidding community who may have been forwarded the 
original Invitation to bid or need to gain access to the bid. If a user attempts to request access with 
someone else's invitation, an email notification will be sent to the bidding contact, the requester, and the ori-
ginally invited contact (if they have an e-mail address on file).

Requests to reopen the bid package can be made after an initial bid as been submitted; before or after the 
due date. Administrators have the opportunity to accept or reject these requests from this page

Note: The Pending Requests link is located on every tab of the Bid Package Details page, except for the 
Bid Tabulation and Permissions tabs.

To accept a bidder's access request
 1. Go to the Bid Package Details page.
 2. Click the Pending Requests link.

The Pending Requests page is displayed.
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 3. Click Accept, to accept the request. The Access Request page is displayed with the following 
options:

 o Add Contact: Select this option to add the requester as an Invited Bidder.
 o Create a New Company: Select this option to add the requester as a new contact for the 

company.
 o Delete Original Invitation: Select this option to delete the requested bidder's invitation.

 4. Click Continue.

The Invite Bidders page is displayed where you can send the bidder a formal invitation to bid.

 5. Enter all required fields.
 6. Click Send.

To reject a bidder's access request
 1. Go to the Bid Package Details page.
 2. Click the Pending Requests link.

The Pending Requests page is displayed.

 3. Click Reject to reject the request. 
 4. Click Yes, Reject the Request to confirm.

The fields and buttons located on the Pending Requests page are:

Access Requests Tab
 l Cancel: Click to return to the Bid Package Details page.
 l Bidding Information: This section provides details of the bid package.

 o Project: The name of the project. Click to open the Project Details page.
 o Bid Package: The name of the bid package. Click to open the Bid Details page.
 o Bid Due Date/Time: The cutoff date and time for bid submissions.
 o Bid Time Zone: The date and time of the bid time zone. The time zone can be modified 

on the Add/Edit Bid Package Details page.
 o Status: Whether the bid package is open or closed.

 l Requests: This table includes the details of the request. The left column lists the requester's 
status, such as if they are an invited or new bidder. The requester's message is also listed in this 
column.

 l Accept: Click to accept the request to bid.
 l Reject: Click to reject the request to bid.

Reopen Bid Requests 
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 l Cancel: Click to return to the Bid Package Details page.
 l Bidding Information: This section provides details of the bid package.

 o Project: The name of the project. Click to open the Project Details page.
 o Bid Package: The name of the bid package. Click to open the Bid Details page.
 o Bid Due Date/Time: The cutoff date and time for bid submissions.
 o Bid Time Zone: The date and time of the bid time zone. The time zone can be modified 

on the Add/Edit Bid Package Details page.
 o Status: Whether the bid package is open or closed.

 l Requests: This table includes the details of the request. The left column lists the requester's 
status, such as if they are an invited or new bidder. The requester's message is also listed in this 
column.

Related Topics:
 l Bid Packages

Assistance for Invited Bidders
When you receive an invitation to bid via email, you can access e-Builder’s online bidder portal and respond to 
the bid package. The bidder portal provides access to the Bid Documents Folders and Bidding Instruction File 
(if one is used). 

Invited bidders can take any of the following actions from the bidder’s portal:
 l Register with e-Builder
 l Access the Bid Package
 l Entering the Invitation Key
 l Review Package Invitation
 l Ask Questions/ View Responses
 l Submit Your Bid Response
 l Submit Your Quote

Bidders Portal - New URLs

As of 2023, the Bidders Portal has a new URL. If you have been automatically redirected from the old URL, 
please note that this service has ended.

Note: We have multiple hyperlinks for the Bidders Portal based on your location. To ensure uninterrupted 
access, please refer to the table below, locate the old URL you were using, and save the corresponding new 
URL.

Important: To ensure a successful login, use only the new URL that matches your previous one. The old 
URLs will no longer work.
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Old URL New URL

https://bidders.e-builder.net https://gateway.app.e-build-
er.net/app/bidders/

https://bidders-us2.e-builder.net https://gateway.app-us2.e-build-
er.net/app/bidders/

https://bidders-us3.e-builder.net https://gateway.app-us3.e-build-
er.net/app/bidders/

https://bidders-us4.e-builder.net https://gateway.app-us4.e-build-
er.net/app/bidders/

https://bidders-gc1.e-builder.net https://gateway.app.ca.e-build-
er.net/app/bidders/

https://bidders-ca1.ca.e-builder.net https://gateway.gov.e-build-
er.net/app/bidders/

Support Information
For technical assistance, contact Technical Support:

Toll-free phone number: 888-288-5717 (U.S.) 

Outside US phone number: 800-580-9322

E-mail: support@e-Builder.net

Video Tutorial

Watch this 7 minute tutorial for a Bid Portal Overview.

Learn More about Trimble Unity Construct - An Award-Winning Cloud-Based Construction Man-
agement Software

Trimble Unity Construct is a cloud-based, digital project delivery capability for capital projects that delivers trus-
ted insight, improved process control, and reduced cycle times, resulting in project cost savings of more than 
4%. 

To learn more about Trimble Unity Construct, visit our website.

Register with e-Builder 

Note: If you previously registered as a bidder in the e-Builder Bid Portal, you do not have to register again.  
Your Bid Portal credentials can be used for all projects and owners who use the e-Builder Bid Portal.

https://bidders.e-builder.net/
https://gateway.app.e-builder.net/app/bidders/
https://gateway.app.e-builder.net/app/bidders/
https://bidders-us2.e-builder.net/
https://gateway.app-us2.e-builder.net/app/bidders/
https://gateway.app-us2.e-builder.net/app/bidders/
https://bidders-us3.e-builder.net/
https://gateway.app-us3.e-builder.net/app/bidders/
https://gateway.app-us3.e-builder.net/app/bidders/
https://bidders-us4.e-builder.net/
https://gateway.app-us4.e-builder.net/app/bidders/
https://gateway.app-us4.e-builder.net/app/bidders/
https://bidders-gc1.e-builder.net/
https://gateway.app.ca.e-builder.net/app/bidders/
https://gateway.app.ca.e-builder.net/app/bidders/
https://bidders-ca1.ca.e-builder.net/
https://gateway.gov.e-builder.net/app/bidders/
https://gateway.gov.e-builder.net/app/bidders/
mailto:support@e-builder.net
https://vimeo.com/374214070
https://assetlifecycle.trimble.com/en/products/software/unity
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EXCEPTION: For bidders who are subsequently awarded a contract, the owner (e-Builder customer) may 
assign you a licensed e-Builder account so that you can participate directly in e-Builder project activities.  In this 
case, your Bid Portal username and password for future bid packages may be changed to match your licensed 
e-Builder account.

The first time you receive an invitation to bid, you must register with e-Builder and obtain a username and pass-
word in order to use the bidder portal. This same username and password can be used to bid on any additional 
projects for any e-Builder customer that you are invited to bid on.

During the registration you will create a username, receive a temporary password via e-mail, and then change 
that password.

To register with e-Builder

 1. Click the link in the bid request email.
The Trimble Unity Construct Bid Portal login page is displayed.

Note: To watch a quick video tutorial about the account creation process or to contact e-Builder Tech-
nical Support, click For product support information.

 2. Click Create Account.
 3. On the Create Account registration page, complete all required fields.
 4. Click Register.

A  temporary password is sent to your email address. If you do not receive the password within 10 
minutes of registering, check your Spam or Junk folder. If the message has still not been received, con-
tact e-Builder Support. 

 5. Click Close.
 6. On the e-Builder Bid Portal login page, enter your username and password and click Login. 

You are prompted to change your temporary password.

 7. On the Change Password page, enter:
 o Current password - The temporary password that you received via email.
 o Password - Enter your new password.
 o Confirm Password - Re-enter your new password.

 8. Select or change your three security questions to answer.
 9. Click Save Password.

A confirmation message is displayed depending on whether the project is currently open for bidding.

 10. Click Continue to view the bid packages that you have been invited to.

Access the Bid Package
To access the bid package, ensure that you  registered with e-Builder. After registering, you will have a user-
name and password that will allow you to login to the bidder portal and access the bid package.

Note: If you do not see the bid package you are expecting, enter the invitation key from the bid invitation 
email into the field at the top of the page. The invitation key is specific to your email address and is case 

http://bidders.e-builder.net/
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sensitive. 
You can also share the invitation key or email link.  When others use your key or link, e-Builder will send a 
request for access to the bid manager and will notify you that the key was used by your colleague.

To access the bid package

 1. Click the link in the bid request email.
The Trimble Unity Construct Bid Portal login page is displayed.

 2. Enter your username and password. 
The Bid Package page is displayed. This page lists all the bid packages that you’ve been invited to and 
groups them into three sub-tabs: 

 o Not Accepted
 o Unsubmitted
 o Submitted

On the sub-tabs, the bid packages are grouped by Bid Due Date into the following statuses:
 o Open
 o Not Open
 o Expired

Note: The Bid Package page displays bid packages that you have been invited to across all e-Builder 
customer accounts.  This page also includes the Project Name beside the Bid Package Name. When 
bid packages are within 48 hours of the due date, they are marked as “Expiring”.  The Bid Manager 
will periodically close bid packages, at which time they will no longer display on the Bidder Portal at 
all. 

 3. Click Bid Archives to view the bids that have been archived. 
The bid packages are grouped by the following statuses:

 o Not Awarded
 o Awarded
 o Declined

 4. Click the name of the bid package you want to access. 
The bid package details page is displayed.

Enter the Invitation Key

The invitation key is specific to your email address and is case sensitive. If you do not see the bid package that 
you were invited to bid on, enter your invitation key.

To enter the invitation key

 1. Locate the invitation key in your email.

 2. On the Bid Packages page, enter the invitation key in the Invitation Key field, which is located at the top 
of the page. Click the blue arrow to submit.
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If you enter an invitation key that was sent to another person, you will be prompted to request bid pack-
age access from the bid manager. Once access has been granted by the bid manager, you will receive 
an email notification.  The person who originally received the invitation key will also receive an email noti-
fying them that you now have access.

Note: If you accidentally created more than one user name for yourself, you may be prompted to 
request bid access.  Contact e-Builder Support for assistance at 888-288-5717.

Review Package Invitation
The Bid Package view contains key package information at the top of the screen.

 l Title:  The Trimble Unity Construct customer account name, project name, and bid package name are 
listed at the top of the page

 l Status:  Displays whether the package is Open or Closed, whether you have accepted or declined the 
bid, and whether you have submitted a response yet.

 l Timeframe:  Displays how much time is left before the bid due date / time, and the bidding time zone.
 l Summary:  Displays the current financial total of your bid response.

The Package Invitation tab contains the following descriptive information published by the bid manager:
 l Bid Info:  The information on this tab varies depending on what the bid manager decided to fill out.  Bid 

package description, contact person, pre-bid meeting details and bid instruction documentation are 
some of the items that may be included.

 l Invitation Documents:  Drawings, specifications and other documentation for the bid are published 
here.  The file/folder name, the version and the date/time it was uploaded are also displayed on this tab.

Tip: To download a file or folder, click   beside the file name. To download all the files and sub-
folders in a folder, click   beside the folder name. A folder containing multiple sub-folders or files will 
be automatically downloaded as a .zip file. A confirmation message will be displayed if the download 
is successful. 

Note: This feature will not be available if the Invitation Document folder provided to you does not 
have a file for download.

 l Addenda: If addenda are published for the bid package, the documentation will be listed here.  Prior to 
submitting your response, you will be required to acknowledge your receipt of every addendum with a 
check mark on the Additional Information tab. If addenda are published after you have submitted a bid 
response, your bid will be set back to Draft status and you will need to resubmit your response. 

When you decide whether you will bid on this project, you can notify the organization of your intentions. 

To accept / decline the invitation to bid

 1. Access the bid package. 
The Package Invitation tab is displayed. 

 2. To accept or decline the invitation, click Accept or Decline. 

In  the Status box, the Bidding field is updated to either Will Bid or Will Not Bid.
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Ask Questions / View Responses
Questions for the bid manager may come up during the bid process .    Using the Q&A  Board tab, you can sub-
mit questions, receive responses, view questions submitted by other bidders, and view the responses to those 
questions.

Note: Bidder names are kept confidential. Viewers are only able to see the questions that have been sub-
mitted by another bidder, but their names remain anonymous.

To ask questions or review responses

 1. Access the bid package.

 2. Click the Q&A Board tab located to the right of the page. 

Note: Questions are listed numerically with the most recent question at the top. To view a question 
and answer, click .

 3. To ask a question, click Submit Question. 

 4. On the Submit Question dialog box, enter the subject and question.

 5. Click Submit Question.             

When the bid manager  answers the question, you will receive an email notification, and your question will be 
bolded until you have clicked on the question and read the answer.  If the bid manager subsequently updates 
the answer, the question will again be bolded until you read it.

Depending on the content of the question, the bid manager may provide the answer to just you or may share 
with all bidders.  Other bidders will see “Another bidder” in the Questionee column, and not your name.

Tip: Click View All to see all questions.      To export the data to a spreadsheet for printing, click Export.

Submit Your Bid Response
After reviewing the bid package invitation, use the Response Form tab to submit your bid response. 

To submit your bid

 1. Access the bid package.
 2. Click the Response Form tab.
 3. On the Step 1: Bid Form tab, enter your pricing on the bid form line items. 

Ensure that you provide pricing at the level of detail required by the bid manager.  Some line items may 
be lump sum, and others may require quantities and unit prices.

Tip: 
- If there are areas that do not pertain to your trade, enter a zero (0) value in that line. 
- The Summary box at the top of the page maintains a running total of your entries for reference.  
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 4. Click  (Save) and ensure that your work is saved periodically.

Tip: (Optional) To export the bid items to a spreadsheet that you can customize or that you can share 

with your team, click  (Download). After updating the spreadsheet, click (Upload) to re-import it.

 5. On the STEP 2: Response Documents tab, click Attach Documents, and upload any supporting doc-
ument needed to support your bid. Any Bid Submission custom fields that have been setup for your 
account will also be displayed here.
All uploaded documents will be displayed in a table at the bottom of the tab for you to review.

 6. On the STEP 3:  Additional Required Info tab, complete any additional questions or qualification state-
ments that have been established by the bid manager. When available, the custom fields set up for 
your account will be displayed on this tab. If any addenda have been issued, you are required to 
acknowledge receipt of the addenda on this page before submitting your bid.

 7. Review the entire Response Form and click Submit.  
 8. When prompted, enter your Trimble Unity Construct portal password and click Submit Bid.

The date and time that you submitted your bid is stamped on your Response Form. You will also 
receive an email confirmation.

Additional Notes
 l After the bid due date/ time has passed, the Submit button will be disabled.  In some circumstances, 

the bid manager may allow late submissions and the button will continue to be enabled.

 l If the bid manager adds or changes a bid item, or publishes an addenda, your bid will be set back to 
a Draft status.  You will receive an email notification and will be required to reconfirm your bid and 
resubmit.

 l When you need to step away from entering the quote, click  (Save). It is recommended that you 
save every 15 minutes. This will ensure that your changes are saved.

 l If there are areas that do not pertain to your trade, enter a zero (0) value in that line item.
 l If you have your qualifications in Word® or another program, copy and paste them into the qual-

ifications.
 l It is required that you acknowledge all the addenda, even if they do not pertain to your trade.
 l It is recommended that you submit your quote at least 15 minutes before the due time so that you 

can rectify any errors.  To submit the quote, you must complete all the fields and acknowledge  the 
addenda items. 

 l Upon bid submission, a folder will be created for the bid containing all files from both bid submission 
custom fields and supporting documentation in the Bid Tab. The folder will be visible in the Docu-
ments module after the bid tabulation is opened.

Recall your Bid Response
After submitting a bid, you can make changes to your bid before the due date/time without any interaction from 
the bid manager.  The bid manager has no record of your bid response until you click Submit again.

To recall your bid response
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 1. On the Response Form tab, click Recall Bid. 
 2. Optionally provide a reason for your recall and then click Yes, I am sure.

Your previous submission information is displayed on the Response Form tab.

 3. Click Submit to resubmit your bid prior to the bid due date/time.

Submit a Quote
The bid manager may set up the bid package to only accept quote documentation, such as for initial pre-qual-
ification bids.  In this situation, the Response Form does not have any sub-tabs, and you will upload a file con-
taining your response instead of entering line item pricing.

Note: If the bidder needs to submit a revised quote prior to the bid deadline, use the Submit Quote button 
and re-upload a new document.  The Recall Bid function is not available in this type of bid package.  

To submit your quote

 1. Access the bid package.
 2. Click the name of the bid package you want to access.  
 3. On the Response Form tab, click Submit Quote.
 4. Upload the required files to the popup window and then click Continue.

The date and time that you submitted your bid is stamped on your Response Form. You will also 
receive an email confirmation.
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